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1. General Information  
 
In this chapter you will find information on the explanation of the terms used by the Pilot 
Pro, the steps on creating a project and some special information regarding the 
programming of Pilot One.    
 

1.1. Wording (setting up your Command Menu Tree.) 
 
Device A new Device is created when you click Create Device.  Each device 

can then be linked to a menu command that has subcommands or 
submenus.  The device (e.g. Television) can be activated in the Pilot 
after sending the Project File /configuration to the unit via computer 
download.   Each device also contains one “empty” IR Device (--
01.ICP) should you choose to not build a database of IR signals but 
scan directly into the unit.  Similar to the Pilot One menu tree. 

 
IR Device IR Devices (new or existing) can be created, edited or added by 

using the tab Edit Device.  While creating and editing the file it has 
the extension IXP and when finished (after closing the window) it has 
the extension ICP.  Each IR Device you create contains 51 
“empty” IR Buttons (slots) to link and scan IR commands into.  
The name of each IR Device will then be available in the Pilot unit for 
activation after downloading the configuration or for future jobs with 
the same brand.  Example - “RCA TV“ for the device “Television “ in 
the Main Menu tree. 

 
IR Button Where IR Signals are stored within the new IR Device you create.  

This is the “database” of IR signals you’ll use later.  There are 
51available IR-buttons for each IR Device.  These IR Button slot 
names are arbitrary, have fixed names, and are only seen by the 
installer.  The end user does NOT see these 51 slots.   

 
                               Steps: 
 

1)   Build an empty menu tree. 
2)   Create an IR file Database (.icp) by naming and scanning in 

IR signals to the 51 Edit Device button slots while connected 
to your computer. 

3) Link (Configure) your new IR signals with your new device 
commands in the user’s main menu tree.  

 
 
(See Section 4 and Section 5 for more details on these steps.) 
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1.2. Overview on Creating a Project 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   
BUILD YOUR PROJECT FIRST BEFORE YOU START TO SCAN, LINK ACTION 
AND CONFIGURE TO YOUR NEW MENU.    
 
** VERY IMPORTANT TO COMPLETE AND CREATE ALL MENU TREES 
BEFORE VOICE TRAINING. (SEE SECTION 6.2 FOR IMPORTANT 
INFORMATION ON THIS STEP.)      

 

1.3. Pilot One 
 
The trees in the menu of the Pilot One cannot be changed.  There will be no displayed 
wordlist in an opened Pilot One project.   If an incorrect configuration is transferred to the 
Pilot One it will not accept the menu AND WILL DAMAGE THE UNIT.  
 
 

-Scan or add IR signals from 
a file for a saved IR device 

4. Configure the commands 
   - Link the IR Buttons 
   - Link additional macro signals  

1. Create a menu 2. Create your  
    devices 

3. Create an IR Device 



 

 
 
 

5

5
Manual 

2. Projects 
 
Pull-Down menu in main form:  File – Project list 
 

 
 
 
New Project: 
 
 Start in the Default Tab where you can see default Project templates. 
  
 You can Drag and Drop a project from the Default tab to the Projects Tab to 

create a new project or just use the New Project button. 
 
 For a Pilot Pro project you can start with a new project, a pre-programmed 

default project or a RE-NAMED project from an existing job.  (You do this by 
selecting COPY and re-naming the project.)    

 
 Select the Project type: 
  
 AbleNet Pilot One  - To load a non-changeable Pilot One project. 
 Default Small - To create a changeable Pro project. 
 Two Rooms  -  Same. 
  
 
                    As soon as you have named the new project, and confirmed it, the new 

project will be listed. 
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Open: Opens the selected project. (The project can also be opened by double-
clicking.) 

 

  
 
Delete:  Deletes the selected project from the list. 
 
Close:  Closes the window.   
 
Copy: Allows you to copy an existing project and re-name it to another project 

name.  This step is good for when you want to keep and/or add certain 
menu trees from a previous job to a new job.  You can then copy and 
rename for your new customer and edit as needed. 

 
Export: Exports the selected project from the list into a file with (*.ppr).  The 

original name remains when exporting a project (even if the export file has 
a different name.)  The file can only be imported if there is no existing 
project with the same name. 

 
Import: Import a file (.spr for older Sicare projects) or .ppr for new Pilot Pro project.   
 
(.ppr files are great for e-mailing and sharing projects.)  
 
 
Note: 
 
You can also Drag and Drop a project from the Project tab back to the Default tab to 
create a new default project. 
 
 
 
  



 

 
 
 

7

7
Manual 

3. Create / Edit Menus 
 

 
 
 
 
Wordlist: The wordlist commands are on the left side and can be used to build your 

command menu.  DoubleClick on the word to add it to the menu tree. **The 
menu tree can contain up to 92 different words. 

 
The new word is always added to any currently selected menu point.  To add a word into 
the main menu tree no other words should be highlighted.  Double click in a free area 
(white space) below the menu tree and then add your next word. 
 

NOTICE 

Only device names (e.g. Television, Telephone) or Room names (e.g. Bathroom, Living 
Room) can be added to the main menu tree branch. You can later “activate” them in the 
programming mode of the Pilot .  IMPORTANT - These main devices/room name 
commands are ALWAYS available during voice-operation (if the default option “Device 
Selection” is activated for each.)  Just say the word! 
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3.1. Menu Settings (These are default settings.)  
 
If a menu item has sub-menu items there are different settings available. These options 
can be changed within the project for any menu. (Be careful if you change these 
settings.)  If a corresponding menu item is activated the window “Menu Settings” is 
available in the Edit Menu tab: 
 
 

  
 
 
 
next: If this field is selected then the command “next“ is available in this 

menu.  Issuing this command Pilot changes automatically to the next 
menu point (without executing it.) 

do it:  If this field is selected then the command “do it“ is available in this 
menu. Using this command Pilot executes the currently displayed 
menu point.  (Just like pushing the right red “OK” button on Pilot.) 

sleep: If this field is selected then the command “sleep“ is available in this 
menu.  Issuing this command Pilot changes to sleep mode and will 
only accept the command “wake up.“ 

device selection: If this field is selected you may change directly to other menus off of 
the main menu. If you do not wish to use this option you need to 
insert a menu point that leads you back to the main menu. 

double digits: This option is used when two-number commands are needed (i.e., 
selecting channels on your television). By selecting this option, Pilot 
will wait about 2 seconds for a second number to be added before it 
sends the infrared signal.  If you issue a second command both 
signals will be sent one after the other.  Be careful.   

   
  Better to use macros to send multi-channel numbers.  
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3.2. Example: Creating a menu in an empty project 
 
Command word “Lamp“ with the corresponding commands “switch on“ and “switch off“ to 
be created. 
 

1. Start the program and open “Project list.” 
 
2. Select “Default Tab” and choose a project.  . 
 

 
 

3. Click on new (yellow folder) to create a new project and add a name for it.  It will 
now place it into the Projects Tab. 

 
4. Open the new project.  (Continued on page 10.) 
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5. Double-Clicking on the word “Lamp” in the word list will add it to the project 
window.  You can also use “Add Command” button after you select the word with 
one click!! 
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6. Now double click on the word “switch on” in the word list (or click on it once and 

use “Add Command”) to add it to “Lamp“. 
  

 
 

7. “Lamp” will stay high-lighted.  Select the word “switch off” in the word list (repeat 
step 6 above) and it will be added to the menu tree under “Lamp.” 

  

 
 
8. To Configure the commands “switch on” and “switch off” into RF X-10 signals:  

Click the word and choose the Configure Tab, select RF, push the “+” button and 
then choose the appropriate X-10 signal - (e.g., A1 On, A1 Off.)  

9. To Activate “Lamp” select “Lamp”, click on “Create Device” in the “Edit Menu” 
Tab.  Now “Edit Device” Tab is enabled too.  Check (--01.ICP) and click Save 
Changes (floppy disk) icon.   You have now activated “Lamp” and its commands 
are set to output RF X-10.   

 
Selecting (--01.ICP) activates the menu tree command word.  This also occurs 
automatically when you create an .ICP file for an IR device such as TV.  If you send 
a Project to the Pilot and don’t see the word you have created you may need to 
manually activate the word by going into the Pilot Configuration (hold both red 
buttons down together) and scroll down until you see the device.  Activate 
manually by using (--01.ICP.)                
 

Deleted:  
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4. Assigning and Creating Devices and .ICP file 
 
Selecting a main menu point will allow you to click the “Create Device” Button.  If the 
command menu word (Television, etc.) needs to have an IR database assigned, or 
created, the steps that follow will show you how.   
 

 
 
The Edit Device Tab appears and the corresponding .icp dialogue box will be opened. 
 

 
 
Every device will always contain at least one “empty” IR Device (--01.ICP) to be used or 
not.  It cannot be deleted nor edited.  It contains NO IR signals and serves as an “empty” 
IR device for future additions of signals without using a PC if you choose (see Section1.) 
 
Options: 
 
New IR Device:     Enter a custom name for the device to be added.  The name entered 

serves as a file name and is displayed on the Pilot display in 
Configuration mode as the device name (i.e., Sony TV) for the added 
device (See 1.1)  This newly added IR Device will also be displayed 
in the list of all IR Devices with the suffix .ixp and can be edited. 
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Add IR Device: Opens a dialogue box where you can choose from a list of 

previously saved IR devices (from other projects) to add to your 
new project.  When added it appears as a non-editable IR device 
(.icp) but choose “Edit IR Device” to edit it if you need to. 

 
Delete IR Device: Deletes the selected device from the list. 
 
 
 
 
Copy IR Device:        Copies the selected IR device (i.e., Sony TV) from the current 

project into a list of globally available IR devices. 
 
 
 
Edit IR Device: Saved IR devices have the suffix .icp and cannot be edited. 

Clicking on “Edit IR Device” converts the selected IR device into 
(.ixp) and is now ready for editing or new scanning. 

 
Save IR Device: Saves your changes and “closes” the open IR Device file. 
 If you edit a device before saving you will be asked if you 

want to save changes or not. 
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4. Continued - Working with .ICP files 
 
** Working with and creating .icp files (i.e., Sony TV.icp, DisnNet.icp) can appear 
challenging however once you learn the steps it will be the same for every project 
and every device.  IMPORTANT – These button slots are arbitrary, the same for 
every new .icp file and are ONLY used by the designer.  The end user does NOT 
see these 51 slots.  Remember – “10.up” for example, is only an empty slot for 
storing an IR scan from a remote control.  You will later “link” the signal, stored in 
“10.up”, to a main menu tree word.  (See Section 5.)       
 
Start building a database of IR scans, for your specific device, using these buttons.  
When you start to edit the buttons you will see either a green check or a red X in column 
to the left.  New .icp files will have the red X.   This list of arbitrary IR buttons (as well as 
their signals) can be selected, added or edited at this time.  Assign and name any signal 
to this specific buttons that you want.  (TIP - A “cheat-sheet” is helpful for this step.) 
 
Scan/Test Signal:  Scanning a new signal for this IR button can be done through the         

Pilot Pro connected to your PC.  (see 4.1 Scanning IR signals.) 
 
 
 
PLEASE NOTE 

Before selecting “Scan Signal“ Pilot MUST be in the STANDBY MODE and connected to a 
PC.  Turn the unit off using the side slide button then turn back on but DON’T push the left 
red button on the Pilot. Battery symbol ONLY signifies standby mode. 
 
Signal from file: Signals from files can be selected from an existing IR project that has 

been previously scanned or one from an older Pilot menu that must 
be converted first.  (see 4.2 Signal from File.)  FYI – There may be 
some existing files in this option but are for European usage and can 
be deleted if you choose. 

 
Edit Signal: Allows you to change the signal name and length of the signal on the 

list.  Highlight the line to edit it.  (Example – A channel up scan you 
created may be to “long” and it makes the channel to jump more than 
one at a time.  Change the length of signal down to 5 perhaps.)  

 
Deleting signal: Deletes the signal assigned to the selected IR button. 
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After naming and scanning a remote control signal to a Signlename button (“slot”) 
it will be displayed in the list of signals and will have a green check. 
  
 

 
 

 
Remember - The number of repetitions, or signal length, and the Signal Name can also 
be edited by clicking on the corresponding field.    
 
 
Save IR Device: Selecting this will save the edited IR device. 
 
 VERY IMPORTANT – Once your scanning work is done, and you have 

assigned as many empty slots to IR signals as needed for that device, 
click Save Button (floppy disk) to save and exit.  Also do this every time 
you make changes or edits to the .icp file.  
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4.1. Scanning an IR signal 
 

PLEASE NOTE FROM SECTION 4 

Before selecting Scan Signal the Pilot must be in the standby mode and connected to a 
PC.  The buttons below are only activated when the Pilot is connected.   It will show 
“PC.....” in the display.  Com 1 or Com 3 MUST be used.  (See Section 8.)  
 
Select “Scan Signal” and you will see this.  (You will name the signal now.) 
  

 
 
 
To test the signal first - Keep the left key on your Pilot pressed down. After approximately 
1 second the display changes to: 
 
 
 
 
 
 
 
 
Put the remote control right in front of the Pilot and push a key. Change the position 
slightly until a bar graph appears in the display.  (The more bars the better the scan.) 
 
 
 
 
 
 
 
 
Release the red key and keep this position. 
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WITHOUT MOVING THE REMOTES push the button Scan Signal.   
 
You now have several seconds to send the signal before it “times out.”  Push the button 
on the remote control of the signal you want to teach to your Pilot.  DO NOT HOLD THE 
REMOTE CONTROL BUTTON DOWN. PUSH QUICKLY SO JUST A FEW 
MILLISECONDS OF IR SIGNAL “PULSE” IS CAPTURED.   It may take up to 20 
seconds before the buttons Scan Signal, Send Signal (To test) and Save will be active 
again. 
 

 
 
Send Signal:   Pilot sends the scanned signal to see if the signal has been scanned 

correctly.  You can point the Pilot toward your actual device (Sony TV) 
push Send Signal and see if the device actual does that command. 

  
You can also test signals which have already be stored in this way.    
 

TIP 

In case the newly added signal does not work correctly, or if it takes a lot of time until the 
buttons become active again, please check the batteries in the remote control.  Low 
batteries and florescent lights are some main reasons for faulty scanning. 
 
Click on Scan Signal again and repeat the above steps if there was a problem with the 
scan.  It will overwrite the previous scan! 
 
Save:  If the scanned signal is working, click Save.   A bar graph will appear 

(see next page) in the display showing the progress of the scan in 
percentages. 
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** Important – For IR Devices that have “Toggle Bit” signals you can use option 
Signal 2 to add the second signal.  Both added signals will be saved and your Pilot 
changes automatically between those two signals when sending.  It is rare to 
encounter remote controls with toggle bits but it occurs now and then. 
 
To exit the scan procedure click Ok then Cancel and this will close the window.  You will 
repeat these steps for all the IR buttons on the remote control that you need. 
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4.2. IR Signal from file   
 
 

 
 
 
This dialog box lists all IR files that are available. Open the chosen file by clicking on the 
tab. Select the desired signal and confirm with OK.  If you have chosen the option As 
Toggle before the signal will be assigned as a second signal to this IR button. 
 
Remember – Signal from File is normally used by advanced Pilot installers and 
programmers who have older Pilot projects and who wish to “re-use” specific 
signals from previous jobs.  Contact AbleNet Technical Support and request more 
details on using “Signal from File.”  
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5. Configuring Menu Items 
 

Pilot One tip 

The functions described in this chapter are not available within a Pilot One project. 
 
Configuring menu items is the last step in preparing your new Pilot project to be 
downloaded into your system.  This step is where you “LINK” your newly created 
.icp files to your main menu word tree.  
 
Basically this step is where you assign the actions you want performed when the 
user gives a voice command.  Example - You will configure the word “Switch On”, 
to send the IR signal” Power”, from the .icp files you’ve created from all your 
scanning work.    The screen shots below show how to configure a Lamp. 
 

 
The following dialogue box appears: 
 

 
 
 
Confirm After you have made changes click “Confirm” to store them. 
 
Restore Displays the last stored actions for this word. 
 
Edit  Opens a dialog to edit the action. Be careful with this as you must know 

what to write. 
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Add: Adds the selected action to the end of the list of linked actions. 
 
 
 
Insert: Inserts the selected action to the selected position of the list of linked 

actions. 
 
 
Delete: Deletes the selected action from the list. 
 
 
. 
 
The various actions can be combined as much as needed or for creating macros. 
 
 
Configuring IR Signals: 
 

 
 
When you click on a sub-menu word in the user’s tree you will select the above 
“configure” tab.  (This corresponds with the .icp files you created in Section 4.)  It sets 
what IR (or RF) signal is actually sent when the user gives the voice command.   
 
VERY IMPORTANT - The left drop-down selection box displays the 51 arbitrary buttons 
you have worked with before.  (They are the same for every device.)  The right drop-
down selection box lists your main menu device words.  Careful – they are not shown 
with specific names (i.e., Sony TV) but you will just see television, cable, etc.  If you have 
more than one TV in the main menu tree then you will see it as television, television1, 
television2, etc.   
 
Select the button on the left drop-down that contains the IR signal in your .icp file and 
press “+”.  The IR signal will now appear in the upper right window as SendButton(..).  
You have successfully linked the word to the command and its corresponding signal.   
 
Only main menu words, already linked to a device, will be seen in the second selection 
box.   
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Radio signals for X-10 Control: 
 

 
 
 
In your Configure tab click RF Signal, then click “+” and a list of Pilot RF X-10 signals 
appear.  (A to P - 1 to 16) plus Dim and Bright. 
 

 
 
By using this tab different X-10 radio signals can be opened.  Select the desired signal 
from the list, determine the length of the signal in the field “repetition” (how many 
milliseconds the Pilot will transmit) and confirm with “OK.”   
 
Radio signals in the list of linked actions are displayed with their name on the top line 
and their signal parameters.
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Other Configuration tools 
 
 
 
Actions for Telephone use: 
 

 
 
 
The Telephone Actions shown are for advanced Pilot programmers.   In North America 
the Pilot is supplied with a fully complete project for AbleNet Telephones and  have 
various access options to suit your needs.   
 
** For instructions on how to use AbleNet Telephones with Pilot refer to the Pilot 
Pro Operators Manual or call AbleNet for assistance. 
 
 
 
Wait: 
 

 
 
Choose a “pause” setting between 1 and 1000.  It appears as Wait(..).   
 
This is used for building macros for favorite TV channels, macro phone numbers or other 
customized macros where a pause may be needed between signals.   
 
Example - for channel 425 you would build a macro using Four, Wait, Two, Wait, Five.  
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Return: 
 

 
 
(By default this feature is disabled.  FOR EXPERIENCED INSTALLERS ONLY!!) 
 
  
Repeat Signal: 
 

 
 
 
Using this function allows a selected IR Button in the left selection box to be continuously 
repeated based on the ms setting from the right selection box.  It can be stopped by any 
voice command.  In the list of the linked action it appears as StartScan(..).   
 
 
Sleep Mode: 
 

   
 
 
Using this function allows you to link the Sleep command to an action.  It appears as 
PushMenu and SetMenu(Sleep) in the upper right.  Be very careful using this function as 
the Pilot “Sleep” controls are pre-set in the software configuration.  Only experienced 
installers should use this function.  
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6. Data Exchange 
6.1. Create File 
 
Before the created configuration (or New Project) can be transferred to the Pilot the 
configuration file must be created. 
 
 

 
 
 
If the menu item Create File is greyed-out then project must be saved first (File – Save or 
Save Button in the Project Toolbar (floppy.) 
 
This dialog is shown while the file is being created. 
 

 
 
 
If all steps are finished with “ok’s” then the window can be closed.  You may at times 
have an error message as the software tries to complete Create File.   If this occurs 
please write down the error message and contact AbleNet Technical Support.  
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6.2. Transfer Configuration 
 

ATTENTION 

Before you click on Transfer Configuration the Pilot must be connected to the 
computer and in Stand By (only a battery symbol in the display).  Start Transfer 
will be available as soon as there is a connection between Pilot and computer 
(Pilot display shows “Pilot PC...“).  
 
Transfer configuration is only available if there is an existing configuration file and the 
configuration file was created after saving the project.   The transfer dialog is shown. 
 
 

 
 
 
 

******** EXTREMELY IMPORTANT******* 
 
 
THE OPTION “KEEP STORED VOICE” IS USED WHEN NO NEW WORDS ARE 
ADDED TO A PRE-EXISTING PROJECT ALREADY DOWNLOADED TO THE PILOT.   
 
IF NO NEW WORDS HAVE BEEN ADDED TO A PRE-EXISITING MENU TREE, AND 
YOU ONLY CHANGED OR EDITED IR FILES, USE “KEEP STORED VOICE.”   
 
IF YOU ADD A WORD TO A PRE-EXISITING MENU TREE YOU MUST RE-TRAIN THE 
ENTIRE VOICE FILE!!!!! 
 
IT IS VERY IMPORTANT THAT YOU PLAN OUT YOUR MENU TREES AND DECIDE 
WHICH IR BUTTONS YOU WILL NEED TO OPERATE A PARTICULAR IR DEVICE 
BEFORE YOU VOICE TRAIN.  DISCUSS THIS WITH THE USER BEFORE YOU 
VOICE TRAIN AND REVIEW ALL THE BUTTONS IN THE TREE FIRST. 
 
After clicking on “Start Transfer” the memory in the Pilot will be deleted before the new 
configuration file is transferred.  When the bar is full and the button shows “Close“ close 
this window to restart the Pilot. 
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6.3. Read Configuration/Read Memory 
 
With these functions you can make a backup of the whole memory (including the voice 
training.)   This should be done upon TOTAL completion of the job!  
 
*.mem = The entire project with voice files uploaded into your PC. 
 
*.cim =  Just the configuration and IR signals. 
 
These files can only be used as back-up files and cannot be edited.   
 
 
Choose the folder where you want to store the back-up file and type in a filename before 
clicking OK.  The Transfer window will be shown and clicking “Start Transfer” will begin 
the reading memory from the Pilot. 
 
 

ATTENTION 

Before you click on “Start Transfer“ the Pilot must be connected to the computer and 
in Standby (only a battery symbol in the display).  “Start Transfer” will be available as 
soon as there is a connection between Pilot and computer (Pilot display shows “Pilot 
PC...“). 

6.4. Transfer Memory  
 
This allows for the transfer of *.mem files back into the Pilot.  Choose the folder where 
the file is located and click OK.  Click “Start Transfer” to begin downloading file. 
 
Great for keeping all your projects safe in case of equipment damage, warranty 
replacement, etc. 
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7. Interface 
 

Menu Extras - Options 
 
Or 
 

 
 
 
 

 
 
You can see all available COM interfaces on your computer. Choose the appropriate 
setting.  (Try to use COM1, COM 2 or COM 3.)  When using a USB-TO-SERIAL Adaptor 
it will usually add many different COM Port settings in this dropdown section.  Pilot needs 
1, 2 or 3 but you try as many as needed to get the link between Pilot and laptop. 
 
Refresh Updates the list of available COM ports if you have connected your USB 

adapter after opening this window. 
 
Test If your PILOT is connected and in Standby it will change between “PC….” 

And empty display everytime you click “Test” 
 
Store Saves the COM port setting. 
 

8. Printing 
 
You can print your menu tree by using the Printer Icon (above the Keyword list) or Save 
to File. 


